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Portable Data Storage
Easy storage and transfer of any file type.

USB 1.1 and 2.0
You can download files at a fast speed. 
(USB  2.0 high speed)

FM Reception (Optional) (See on page 13)
With auto frequency selection feature, you can 
conveniently listen to FM radio broadcasting.

LG 3D Sound
3D sound effects, low tones, and low frequency sound
provide greater sound quality.

Text Viewer
Convenient display of text files (.txt) for reading on the go.

Photo Viewer
Store and display photos on the vivid display for entertaining
slide shows.

Brilliant 1.77" Color TFT LCD
Photos and video are reproduced in vivid detail on the
highly portable 260,000 color TFT LCD.

File Format Flexibility
- Music: MP3, OGG, WMA, WAV (ADPCM), ASF
- Video: LG AVI (The player can be only played the video files

downloaded via LG Media Center.)
- Photo: JPG, BMP
- Text: TXT

MTP / MSC Mode
What is the MTP mode? MTP stands for the Media
Transfer Protocol. MTP applies the latest technology of
Microsoft to support the multimedia devices.

What is the MSC mode? The MSC stands for the Mass
Storage Class. The device in the MSC mode functions
as if the portable memory.

Features
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Please follow the safety instructions closely to reduce the risk of accidents or damage to equipment.

Safety instructions are divided into Warning and Attention:

Keep this manual in an easily accessible place.

Warning Not following the instruction may result in death or serious injury.

Caution Not following the instruction may result in a light accident or damage.

Warnings

Important safety instructions
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Keep this product away from heat. 

Note that the player may malfunction in an
electrostatic environment.

Use the AC adapter shipped with the product
for the safety purposes.

Disconnect the AC adapter and the cable in
case of a lightning or thunder. Otherwise, an
electric shock or fire may occur.

Do not use this product while driving.

Do not insert a metallic object (metal stick
or hair pins, etc) or flammable objects in
the product. Do not drop such objects on
the product either.

Don’t listen to music for a long time. It may
damage your hearing.



Cautions

Important safety instructions
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Do not place the player near a magnet or
within the magnetic field.

Do not drop an object or give shock on 
the product.

Clean this product with soft cloth.

Do not operate the product near water, dust,
or soot.

Do not disassemble, repair, or remodel the
product.

Do not disconnect the USB cable while operating
the player after connecting MP3 player to your
PC with USB cable. Otherwise, the data may get
lost.

Do not place an object on the product. 

Keep your computing environment clean and
free.

Back up important data (Note that the manu-
facturer is not responsible for the loss of
major data caused by your mistake)



Converting video file
MP3 player can be only played the video files downloaded via
LG Media Center.

For details about downloading, see [Converting  video file] of
Help menu on LG Media Center.

USB Mode
MTP Mode
You should download the music file via LG Media Center or
Windows Media Player 10.
You should download the video file, photo file, and text file
via LG Media Center.
You can copy the data file to Data folder. 

MSC Mode
You can copy the Media file to the Removal Disc. (But you
should download video files via LG Media Center.)

Supplying Power via USB
- If the battery status is low when connecting MP3 player to

your PC with USB cable “Please Wait” message is 
displayed for a few minutes and then connected.

- If the battery status is fully discharged, the LCD turns off
for a few minutes even during connecting.

- If your PC is suspended, MP3 player is also suspended.

- If MP3 player is suspended, the LCD turns off and the
charging stops. After an hour, MP3 player turns off auto-
matically.

Important safety instructions
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Low Battery

Please Wait...



REGULATORY INFORMATION
FCC Part 15
This product has been tested and found to comply with
the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference
when the product is operated in a residential installation.
This product generates, uses and can radiate
radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause
harmful interference to radio communications.
However, there is no guarantee that interference will
not occur in a particular installation. If this product does
cause harmful interference to radio or television reception,
which can be determined by turning the product
off and on, you are encouraged to try to correct the
interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the product and

receiver.
- Connect the product into an outlet on a circuit different

from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV techni-

cian for help.

FCC WARNING
This equipment may generate or use radio frequency 
energy. Changes or modifications to this equipment may
cause harmful interference unless the modifications are
expressly approved in the instruction manual.

You could lose the authority to operate this equipment
if an unauthorized change or modification is made.

- Changes or modifications not expressly approved by
the party responsible for compliance could void the
user's authority to operate the equipment.

- This MP3 player is for use only with UL listed personal
computers that have installation instructions detailing user
installation of card cage accessory.

Important safety instructions
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CAUTION
PLEASE READ AND OBSERVE ALL WARNINGS
AND INSTRUCTIONS IN THIS OWNER MANUAL
AND THOSE MARKED ON THE UNIT. RETAIN THIS
BOOKLET FOR FUTURE REFERENCE.
This set has been designed and manufactured to assure
personal safety. Improper use can result in electric shock or
fire hazard. The safeguards incorporated in this unit will 
protect you if you observe the following procedures for
installation, use, and servicing. This unit does not contain
any parts that can be repaired by the user.
DO NOT REMOVE THE CABINET COVER, OR YOU
MAY BE EXPOSED TO DANGEROUS VOLTAGE.
REFER SERVICING TO QUALIFIED SERVICE PERSON-
NEL ONLY.

1. Read these instructions.
- All these safety and operating instructions should be

read before the product is operated.
2. Keep these instructions.

- The safety, operating and use instructions should be
retained for future reference.

3. Heed all warnings.
- All warnings on the product and in the operating 

instructions should be adhered to.
4. Follow all instructions.

- All operating and use instructions should be followed.
5. Do not use this apparatus near water.

- For example:near a bath tub, wash bowl, kitchen sink,
laundry tub, in a wet basement; or near a swimming
pool; and like.

6. Clean only with dry cloth.
- Unplug this product from the wall outlet before cleaning.

Do not use liquid cleaners.
7. Do not block any ventilation openings. Install in 

accordance with the manufacturers instructions.
- Slots and openings in the cabinet are provided for

ventilation and to ensure reliable operation of the
product and to protect it from over- heating.

- The openings should never be blocked by placing the
product on a bed, sofa, rug or other similar surface.
This product should not be placed in a built-in 
installation such as a bookcase or rack unless proper
ventilation is provided or the manufacturer instructions
have been adhered to.

- Important Safety Instructions
8. Do not install near any heat sources such as radiators,

heat registers, stoves, or other apparatus (including
amplifiers) that produce heat.

9. Do not defeat the safety purpose of the polarized or
grounding-type plug. A polarized plug has two blades with
one wider than the other. A grounding type plug has two
blades and a third grounding prong. The wide blade or
the third prong are provided for your safety.
- If the provided plug does not fit into your outlet, consult

an electrician for replacement of the obsolete outlet.
10.Protect the power cord from being walked on or pinched

particularly at plugs, convenience receptacles, and the
point where they exit from the product.

Important safety instructions
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11. Only use attachments/accessories specified by the 
manufacturer.

12.Use only with the cart, stand, tripod, bracket, or table
specified by the manufacturer, or sold with apparatus.
- When a cart is used, use caution when moving the

cart/apparatus combination to avoid injury from tip
over.

13.Unplug this apparatus during lightning storms or when
unused for long periods of time.

14.Refer all servicing to qualified service personnel.
Servicing is required when the apparatus has been
damaged in any way, such as power- supply cord or
plug is damaged, liquid has been spilled or objects
have fallen into the apparatus, the apparatus has been
exposed to rain or moisture, does not operate normally,
or has been dropped.

Important safety instructions
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Warning
- To reduce the risk of fire or electric shock, do not expose

this appliance to rain or moisture.

Caution
- The appliance is not intended for use by young children

or infirm persons without supervision.
- Young Children should be supervised to ensure that they

do not play appliance.
- Use of controls or adjustments or performance of

procedures other than those specified herein may result
in hazardous radiation exposure.

Industry Canada requirement
- This Class B digital apparatus complies with Canadian

ICES-003.
- Cet appareil numérique de la classe B est conforme

qa la norme à NMB-003 du Canada.

Warning
- The lithium battery contains lithium and can explode

if it is not properly handled of disposed of.
- Replace only with a battery of the type recommended

by LG.
- Caution: Danger of explosion if battery is incorrectly

replaced. Replace only with the same or equivalent
type recommended by LG. Dispose of used batteries
according to the manufacturer's instructions.

Important safety instructions
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CAUTION
RISK OF ELECTRIC SHOCK 

DO NOT OPEN

CAUTION: TO REDUCE THE RISK 
OF ELECTRIC SHOCK

DO NOT REMOVE COVER (OR BACK)
NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED SERVICE
PERSONNEL.



Important safety instructions
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Disposal of your old appliance

1. When this crossed-out wheeled bin symbol is
attached to a product it means the product is
covered by the European Directive
2002/96/EC.

2. All electrical and electronic products should
be disposed of separately from the municipal
waste stream via designated collection facili-
ties appointed by the government or the local
authorities.

3. The correct disposal of your old appliance will
help prevent potential negative conse-
quences for the environment and human
health.

4. For more detailed information about disposal
of your old appliance, please contact your
city office, waste disposal service or the shop
where you purchased the product.

The working life of  this product is 7 years since
the date of purchase.

This product is manufactured to comply with
the EEC DIRECTIVE 89/336/EEC, 93/68/EEC
and 2006/95/EC.



- Contents of the product are subject to change without prior notice for functional improvement.
- FM Radio reception is optional.

Options By Model

Model Names FM

MF-FM33S O

MF-FM33E X

Package contents
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MP3 player Portable neck strap USB cable AC adapter

Software CD Earphones Quick Setup Guide



Using the neck strap

The supplied neck strap provides a convenient way
to carry your Portable Digital Player.

1 Rotate the bottom part of neck strap in the direction of
arrow.

2 Separate the bottom part of neck strap as shown on the
picture.

3 Connect the strap to the neck strap holder in the player.

Package contents
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Top, front and bottom
views

1 Earphones jack
2 Portable neck strap holder
3 USB port
4 LCD
5 * 5 way button (Up,Down,Left,Right, 

SELECT) 
1) Up ( ) button/Left ( ) button

Moves to a high step of home
menu, EZ menu and setup menu.
- Music mode: Increases volume.
- Video mode: Moves or searches 

to a previous video.
Returns to the 
beginning of video.

2)Down ( ) button/Right ( ) button
Moves to a low step of home 
menu, EZ menu and setup menu.
- Music mode: Decreases volume.
- Video mode: Moves or searches 

to a next video.
3) Left ( ) button/Down ( ) button

Moves to a previous step of all
menu.
- Music mode: Moves or searches 

to a previous track.
Returns to the 
beginning of music.

- Video mode: Decreases volume.
- Text mode: Moves to a previous

page.

- Photo mode: Moves to a 
previous photo.

- Setup mode: Exits the setup mode.
- Total List mode: Exits the total

list mode.
4) Right ( ) button/Up ( ) button

Moves to a next step of all menu.
- Music mode: Moves or searches

to a next track.
- Video mode: Increases volume.
- Text mode: Moves to a next page.
- Photo mode: Moves to a next 

photo.
- Setup mode: Enters the setup

mode.
- Total List mode: Enters the total

list mode.
5) SELECT button

Confirms menu selection.
6 RESET button

* 5 way button

Name of each component
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Right and left views 

1 Microphone hole 

2 Hold switch

3 Play/Pause ( ) button (Power on/off)

4 ez button

5 MENU button

6 Record (REC) button / A-B Repeat

Name of each component
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Before installing the operating 
program
Check the specifications of your PC before using
the Player.

Minimum system requirements
- CD-ROM Drive
- Pentium Ι ΙΙ or higher level CPU / 128MB or larger memory
- 300MB or larger hard disc space, 800 X 600 mode
- Hi-color (16 bit) or higher level video card, Sound card

Operating environment
- The MTP mode is applied to the PC equipped with

Windows XP (SP1) or higher-version OS or the Windows
Media Player 10. To the lower-version OS, the MSC mode
is applied.

Windows Media Player 10
- You can download the file using Synchronize with

Windows Media Player 10 menu.
- For more information, see the Help menu of Windows

Media Player 10.

LG Media Center
- Windows 2000/XP
- Windows Media Player 10 or higher / Internet Explorer

6.0
- Windows Media Player or Internet Explorer will be

automatically installed during installation of the LG Media
Center. Internet connection must be connected in order to
install Internet Explorer.

- The MTP mode is recommended for the LG Media Center.

Installing software
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LG Media Center
1 Insert the operation program CD into the CD-ROM.

2 Select the LG Media Center.

- Refer to page 53 for more information.

3 Follow the displayed instructions.

4 Read the License Agreement. Select the check box, and
click on [Next] button.

5 Select the installation path, and click on [Next] button.

6 Click on [Install] button to start installation.

Installing software

18



7 During installation of the LG Media Center, you can install
the Windows Media Player and the Internet Explorer for
the operating environment.

8 After finishing the installation, click on [Finish] button.

9 Click on “Start” > “All Programs” > “LG Media Center” >
“LG Media Center” to start the program.

Installing Win98SE MSC Device Driver
1 Execute LGE203053 inst.bat under Drivers > Win98SE

folder in the CD-ROM. 

2 Reboot the PC, and connect the MP3 player to the USB
port.

3 The installed device driver can be used as a portable disc
in the Windows Explorer.

4 Check the installation status in System Properties as
shown below.

Installing software
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To use a portable media device - In
the MTP mode
The manufacturer is not responsible for the data loss
caused by your mistake.

What is the MTP mode?

The MTP stands for the Media Transfer Protocol. It applies
the latest technology defined by Microsoft to support multi-
media devices (In the MTP mode, the player will be recog-
nized as a mobile device, not a mass storage, and will inter-
work with the Windows Media Player 10).

• MTP mode
- Windows XP / SP1 or higher OS, and Windows

Media Player 10.
- To use the MSC mode, select the MSC mode in the

USB Mode menu.
- If the Windows OS does not support the MTP, the

player will function in the MSC mode although the
player is set in the MTP mode (Select the MSC mode
for the USB in the setup menu for Windows 98 SE/
ME).

To download files
1 Select the MTP mode from the USB mode of the MP3

player.
- The default is the MTP mode.

2 Connect one end of the USB cable to the USB port of the
PC and the other to the USB port of the player.
- Check whether both ends of the cable are correctly plugged

in.

3 Check whether a new drive has been added in the
Windows Explorer in the PC.
- The drive name may differ depending on the OS.
- ASF Files can only be downloaded by Windows Media

Player 10 or MSC Mode.

4 Select the file to store, and copy it to the folder of the
portable media device.

Connecting to the PC
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Notes
- Disconnecting the USB cable while the file is being

copied may cause malfunctioning of the player.
- The player will be charged when connected to the PC

through the USB cable.
- Copy music files (MP3, WMA, ASF and WAV (ADPCM)) to

the media folder (Convenient synchronization is possible
through the LG Media Center or Windows Media Player 10).

- Download video, photo (JPEG, BMP) and text (TXT) files
through the LG Media Center.

- The player can play only files downloaded from LG Media
Center. (Purchased video, photo (JPEG, BMP), and text
(TXT) files)

- The data folder is supported only for the portable device,
and is not displayed on the MP3 player.

- After the file is copied, the folders will be created in order
of artist (or intellectual property right holder) and the album
title contained in ID3TAG information of the music file. In
the player, select Home menu > Total List > Contents to
view the playing list. In the MSC mode, the playing list is
not supported.

- The downloaded music file is arranged in order of the name
on the [Music] menu and the copied file on the [Video],
[Photo], [Text] and [Total List] menu. If there is the informa-
tion of ID3 TAG track number on the [Artist], [Album] and
[Genre] menu, the file is arranged in order of track number.

- ASF Files can only be downloaded by Windows Media
Player 10 or MSC Mode.

- OGG Files can only be downloaded by MSC Mode.

When MP3 Player is connected to
PC in MTP Mode
1 When MP3 Player is connected to PC.

2 When My Computer is clicked on and [Take no action] is
selected.

Connecting to the PC
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3 When Audio Device is selected.
- Data folder: You can download or upload all data files.
- Media folder: You can download only the file that Windows

Media Player 10 supports.

4 Upon manual setup
- When [Synchronize Media File with Device] has been

selected or the Windows Media Play 10 is opened (The
data cannot be uploaded to the PC from the Windows
Media Player 10)

5 When the files to be synchronized are dragged to the left 
window

6 When files are synchronized and a new folder is created.

Connecting to the PC
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To use the removable disc - In the
MSC mode
What is the MSC mode?
The MSC stands for the Mass Storage Class. The
device in the MSC mode functions as if the portable
memory.

To download files
1 Select the MSC mode from the USB Mode menu in the

MP3 player.
- For more information, see the setup menu tree screen (See

on page 49).

2 Connect one end of the USB cable to the USB port of the
PC and the other to the USB port of the player.
- Check whether both ends of the cable are correctly plugged

in.

3 Check whether a new drive has been added in the
Windows Explorer in the PC.
- The drive name may differ depending on the OS.

4 Drag the file to copy to the removable disc drive.

- Disconnecting the USB cable while the file is being copied
may cause malfunctioning of the player.

- The player will be charged when connected to the PC
through the USB cable.

- Download video files from LG Media Center.

- Download the JANUS DRM-applied files through the
Windows Media Player 10 or LG Media Center (MTP Mode
only)

- Download X-Sync DRM-applied files through the LG Media
Center.

Connecting to the PC
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To upgrade firmware
You can update the firmware for addition and
change of features of the player and for functional
improvement.

1 Check the model number at the company website, and
download the latest version.

- http://www.lge.com > Support > Download > Software
(The contents may differ depending on the website.)

2 Decompress the downloaded files. Then, FM33.rom file
will be displayed.

3 Connect the USB cable to the MP3 player and the PC.

4 Check whether a new drive has been added in the
Windows Explorer in the PC.

- The drive name may differ depending on the OS.

5 Select FM33.rom file and copy it to the newly added
drive.

- In the MSC mode: Highest root

- In the MTP mode: Data folder

6 To safely remove the device, remove the USB cable.

7 When "Firmware upgrade?" message is displayed, click

on button.

8 The firmware updating progress bar will be displayed.
After completion, the power will be automatically turned
off.

- Wait till the power is automatically turned off.

9 Turn on the MP3 player, and check the updated version
of firmware. (Home menu > Setup > General > System
Info).

Replacing firmware
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To use the AC adapter
1 Connect the AC adapter to the AC outlet.
2 Connect the USB cable to the USB port of the player.

To Charge the battery
This player will be automatically charged when power
source is connected.
- Charging time: Three hours (AC adapter)
- Playback time

Music file: About 35 hours (for 128Kbps/ 44.1KHz EQ 
normal)

Video file: About 8 hours
Viewing Photos while playing music : About 8 hours

- On the display of the player, the charging status will be
displayed as follows:

- After charging is completed, will appear.
- Do not disconnect AC Adapter while the player is starting

up. The data may get lost.
- Battery may completely discharged first time you purchase

the product. Charge the battery first.

ChChhh

Installation and connection
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To connect the USB cable
1 Connect one end of the USB cable to the USB port of the

PC and the other to the USB port of the player.
- Check whether both ends are correctly plugged in.

2 If the USB device is normally recognized after the cable is
connected, the following will be displayed.
- The version is displayed on the LCD.

3 In case of a correct connection, an icon will be displayed
on the task bar of the PC.
- The icon shapes on the task bar may differ depending on

the OS of the PC.

Installation and connection
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To disconnect the USB Cable (In
the MSC mode)
This feature is to safely remove the player from the PC
after uploading or downloading the files.
- Disconnect from the PC upon the connection in the MTP

mode.

1 Double-click on Remove Hardware icon on the task
bar of the PC.

2 Click on [Stop] button when the window appears.

3 Click on [OK] button.

4 After a message that the large-capacity USB storage can
be safely removed is displayed, remove the player from
the PC.
- If the USB cable is disconnected while storing or deleting

the file, the data may get lost.

Installation and connection
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To Turn on/off the power
Press and hold button for about 2 seconds until the
player is turned on.
Press and hold button for about 2 seconds again to
turn off the player.
- Downloading files in the MSC mode may take time for rebuild-

ing depending on the number of files.

Lock feature
This feature locks the player to prevent it from operat-
ing when you accidentally press a button.

1 Slide switch in arrow direction to lock the player.

- Upon locked status, will be displayed on the LCD. Upon

pressing of each button, will appear for two seconds and
disappear.

2 Slide switch to the opposite of arrow direction to
unlock the device.

Reset feature
This feature is to reset the player if the player is not
operated normally.

1 Press the RESET button when the player is not operated
normally.

2 After the power is turned off, press and hold button
for about two seconds. Then, the power will be turned on.
- When the player is connected to the AC adapter or the play-

er is connected to PC with USB cable, it will be automatical-
ly turned on.

- Reset function initializes setting values.

Volume control
Press or button to control the volume.
- The volume level can be adjusted by 40 steps. (Min,

1 - 39, Max)
- If you press and hold or button for about 2 seconds,

the volume levels will decrease or increase by 2 steps.
- The default volume is 20.
- To protect hearing, the maximum volume is set as 25 

when you turns on the player.

Basic operation
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Home menu screen
You can operate various features by using the Home menu.

* Home menu screen varies according to product models
(See on page 13)

1 Music: Plays the music files.
2 Video: Plays the video files.
3 Photo: Plays the image files.
4 Radio: Receives and records FM broadcasting.

(Optional according to model)
5 Record: Records the voice.
6 Text: Displays the text file.
7 Setup: Sets the operating environment of the player.
8 Total List: Displays the playable total list.

General operations of Home menu
1 Press and hold MENU button for about 2 seconds to 

display the Home menu.

2 Press or button to select the desired menu.

3 Press or SELECT button to enter submenu.

4 Press or MENU button to return to the previous
menu.

Basic operation
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To play Music screen

1 Display

2 Music information display

3 Playing time bar

4 Playback time

5 Battery status

6 Current time

7 Alarm setting display

8 A-B Repeat display

To play the music file
1 Move to the Home menu, and press or button to

select [Music] menu.

2 Press or SELECT button to enter the submenu.

3 Press or button to select the music file.

- The supported music format : See on page 57.

4 Press or SELECT button to play.

Note:
You can play other music file on the music file list while
playing a music.
1. Press MENU button during playback.

- The music file list appears.

2. Press or button to select the music file. And then

press or SELECT button to play the selected file.

- Press and hold MENU button for 2 seconds to display home
menu.

- Select the “Now Playing” or press button to return to
the playing mode in [Library].

Playing music
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Pause
1 Press button during playback.

2 Press button again to resume playback.

To search the previous or next file
Press or button to go to the previous or next music.

- If you press button after five seconds of playing time, the
current music will be played from the beginning.

- If you press button within five seconds of playing time, the
previous music will be played from the beginning.

Speed search
Press and hold or button for two seconds during
playback.
- It skips to the previous next or file from the beginning or the

end of the music.

A-B repeat
This feature can only set the current playing music.

1 To set the starting point during playback, press REC 
button.

- icon appears on the LCD.

2 To select the ending point, press REC button again.
Then, the Repeat feature will be set.

- icon appears on the LCD.

3 To cancel Repeat feature, press REC button again.

- icon disappears on the LCD.

Playing music
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Library
If you download the music file from internet or PC, the MP3
player rebuilds them.

Now Playing
This feature displays the playing mode screen of current
music file.

My Playlist
You can select and manage your own playlist.
1 Select the music you want to add on the [My Playlist] of

[Library] list and then press ez button.

- icon changes to icon and it is added in [My Playlist].
- It can add one at a time.

2 You can confirm and play the added music in [My
Playlist].

3 Press ez button again to delete the added music in [My
Playlist].

- icon changes to icon.
- When the list is updated, the my playlist will be automatical-

ly disabled.

PC Playlist
You can play the MP3 player automatically  the playlist cre-
ated in the WMP 10 (Windows Media Player 10) or the LG
Media Center through the Auto Sync mode.

- When the playlist and corresponding files are unchecked
in the Auto Sync mode, music will be deleted in the MP3
player. It is recommended to keep all Music files always
checked.

All Music
Plays the total music in [Library].

Artist
Plays the music by artist.

Album
Plays the music by album.

Genre
Classifies and plays music by genre.

Recorded File
Plays the radio recording file (Optional) or voice recording
file.

Playing music
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EZ menu
You can set the desired function or switch to the other mode
using EZ menu.

1 Press ez button to display EZ menu screen while playing
or pausing.

2 Press or button to move to the desired item.

3 Press or SELECT button to move to the submenu.

4 Press or SELECT button after changing the setting

by pressing or button.

- Press button to exit without change.

5 Press ez button to exit the EZ menu.

Bookmark Set/Move/Cancel
You can move to the point you set while playing the music.

1 ez button > [Bookmark] > [Set]/[Move]/[Cancel]

- If the bookmark is not set, [Set] menu will only appear.

2 Once the bookmark is set, the menu will be automatically
changed into [Move] and you can only change the book-
mark to [Cancel/Move].

- By selecting [Move], you can go to the bookmarked point.

3 If the bookmark is canceled, the menu will be automati-
cally changed to [Set].

- When the list is updated, the bookmark will be automatically
disabled.

Media selection
You can view the photo or text while listening to the music
simultaneously.
1 ez button > [Media] > [Photo]/[Text]

- Press SELECT button to move between the full view and
four-division view in the photo mode.

- You can control the volume while viewing the photo or text.
(Only in playing the music)

- If there is no photo or text, “No File” message is displayed.
- If the [Media] is set to the [Photo]/[Text], [Media] will be

automatically changed to [Music].

2 ez button > [Music] > [Back]/[Cancel]/[Next]/[Previous]

- [Back]: You can move to the music mode.
- [Cancel]: The music mode will be turned off.
- [Next]: You can play the next music.
- [Previous]: You can play the previous music.

Playing music
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Play Mode

1 ez button > [Play Mode] > [Play All]/[Repeat All]/ [Random
Play]/[Random Repeat]/[Repeat One]

- [Repeat One]: Plays the current file repeatedly.
- [Play All]: Plays the music in order within the selected folder.
- [Repeat All]: Plays the music in the repeatedly within the 

selected folder.
- [Random Play]: Plays the music randomly within the 

selected folder.
- [Random Repeat]: Repeats the music randomly within the 

selected folder.

Brightness
You can adjust the brightness level from 1 to 4.

1 ez button > [Brightness] > [1 - 4]
- The default brightness is 3.

EQ
You can set the sound effect.

1 ez button > [EQ] > [AUTO EQ]/[NORMAL]/[POP]/[ROCK]/
[R&B/SOUL]/[HIPHOP/RAP]/[JAZZ]/[CLASSICAL]/[DANC
E]/[LIVE]/[USER EQ]

- If you set the EQ, 3D sound is automatically changed to
[Off].

- [USER EQ]: Home menu [Setup] > [Music] > [Sound Effect]
> [EQ]

3D Sound
You can experience 3D sound effects.

1 ez button > [3D Sound] > [Off]/[3D Expander]/[Stadium]/
[Concert Hall]/[Club]/[Room]/[Bass Boost]/[X-live]
- If you set the 3D sound, EQ is automatically changed to

[NORMAL].
- If OGG file is Q10 500Kbps or higher and VBR file, 3D

sound effects may be small.

Information
Displays the information of the music file.

1 ez button > [Information] > [View]

- You can check the information of file name, play  time,
bitrate, file size, sampling frequency and CODEC.

Playing music
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To play video
MP3 player can be only played the video files downloaded
via LG Media Center. For details about downloading, see
[Converting  video file] of Help menu on LG Media Center.

1 Move to the Home menu, and press or button to
select [Video] menu.

2 Press or SELECT button to enter the [Video] menu.

3 Press or button to select the video file.

4 Press or SELECT button to play.
- Video clips are played in “Repeat Folder” mode by default.

5 Enter to the video list screen if MENU button is pressed
while playing the video.
- Press and hold MENU button for two seconds to enter

home menu.

- Press button to return to the playing mode from video
list screen.

To Play / Pause
1 To pause, press button once.

2 Press button again to resume playing.
- The video file will be displayed on the horizontal screen.

To play the previous or next video file
1 Press or button to select the previous or next file.

- Moving to the previous/next file and playing it.

- If you press button after six seconds of playing time, the
current video file will be played from the beginning.

- If you press button within six seconds of playing time, the
previous video file will be played from the beginning.

Speed search of video files
1 Press and hold or button for more thantwo sec-

onds while playing video file.
- The file will start playing as soon as you stops pressing

the button.
- It moves to the next video file in the ending point but

does not move to the previous video file in the begin-
ning point.

Capture Screen
1 After pausing of the video file, press REC button to store

the image on the display.
2 Check the stored screen in Photo menu.

- A file named P060825_0001(Year Month date_order) will
be created.

Playing video
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EZ menu
You can set the desired function or switch to the other mode
using EZ menu.

1 Press ez button to display EZ menu screen while playing
or pausing.

2 Press or button to move to the desired item.

3 Press or SELECT button to move to the submenu.

4 Press or SELECT button after changing the setting

by pressing or button.

- Press button to exit without change.

5 Press ez button to exit the EZ menu.

Bookmark Set/Move/Cancel
You can move to the point you set while playing the video.

1 ez button > [Bookmark] > [Set]/[Move]/[Cancel]

- If the bookmark is not set, [Set] menu will only appear.

2 Once the bookmark is set, the menu will be automatically
changed into [Move] and you can only change the 
bookmark to [Cancel/Move].
- By selecting [Move], you can go to the bookmarked point.

3 If the bookmark is canceled, the menu will be automati-
cally changed to [Set].

- When the list is updated, the bookmark will be automati-
cally disabled.

Brightness
You can adjust the brightness level from 1 to 4.

1 ez button > [Brightness] > [1 - 4]
- The default brightness is 3.

Information
Displays the information of the video file.

1 ez button > [Information] > [View]

- You can check the information of file name, play time
and volume.

Playing video
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View the photo file
1 Move to the Home menu, and press or button to

select [Photo] menu.

2 Press or SELECT button to enter the [Photo] menu.

3 Press or button to select the photo file.
- The supported photo file format : JPG, BMP

4 Press or SELECT button to play.
- Press SELECT button to move between the full view and

four-division view in the photo mode.
- Enter to the photo list screen if MENU button is pressed

while viewing the photo.
- Press and hold MENU button for two seconds to enter to

home menu.

- Press button to return to the playing mode from photo
list screen.

- Large-sized photos may not be opened or played.
- In case of BMP file, only 24-bit colors will be supported

(Only the BMP files downloaded in the MSC mode are sup-
ported).

- In case of the JPG file downloaded from the LG Media
Center, all photos can be viewed regardless of the size. It is
recommended to download JPG files from the LG Media
Center for quicker display.

To view the previous or next photo
Press or button to view the previous or next photo.

View Photo File
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EZ menu
You can set the desired function or switch to the other mode
using.

1 Press ez button to display EZ menu screen while viewing
photo file.

2 Press or button to move to the desired item.

3 Press or SELECT button to move to the submenu.

4 Press or SELECT button after changing the setting

by pressing or button.

- Press button to exit without change.

5 Press ez button to exit the EZ menu.

Media selection
You can listen to music or radio while viewing the photo file.
(FM radio reception is optional.)

1 ez button > [Media] > [Music]/[Radio]

- If the [Media] is set to the [Music]/[Radio], the [Media] will
be automatically changed  to [Music]/[Radio].

- You can control the volume level while viewing the photo.

2 ez button > [Music]/[Radio] > [Back]/[Cancel]/[Next]/
[Previous]

- [Back]: You can go to the [Music]/[Radio].
- [Cancel]: The [Music]/[Radio] mode will be turned off, the

mode will be changed to [Media].
- [Next]/[Previous]: Plays the previous or next music in case 

of [Music] mode.
Plays the previous or next channel if there
are stored channels in case of [Radio] 
mode.
Displays the [Cancel] or [Back] the if there
are no stored channels in case of [Radio] 
mode.

View Photo File
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Slide Show
You can set to On/Off the slide show.

1 ez button > [Slide Show] > [On]/[Off]
- [On]: Executes the slide show.
- [Off]: Turns off the slide show.

- Press button to pause or restart while executing the
slide show.

- LCD does not turn off while executing the slide show.

Slide Interval

1 ez button > [Slide Interval] > [2sec]/[3sec]/[4sec]/[5sec]
- You can set the slide show interval.

Display

1 ez button > [Display] > [1 photo]/[4 photos]
- [1 photo]: Displays 1 photo.
- [4 photos]: Displays 4 photos.
- Press SELECT button to move between the full view and

four-division view in the photo mode.

Brightness
You can adjust the brightness level from 1 to 4.

1 ez button > [Brightness] > [1 - 4]
- The default brightness is 3.

Background
You can select photo file to music background on the photo
mode.

1 ez button > [Background] > [Music Background]

Information
Displays the information of the photo file.

1 ez button > [Information] > [View]
- You can check the information of file name, file size and

volume.

View Photo File
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View Text File
1 Move to the Home menu, and press or button to

select [Text] menu.

2 Press or SELECT button to enter the [Text] menu.

3 Press or button to select the text file.

4 Press or SELECT button to view.
- Enters to the text list screen if MENU button is pressed

while viewing the text.
- Press and hold MENU button for two seconds to enter to

home menu.

- Press button to return to the playing mode from text list
screen.

- It may take time to load according to a large-sized text file.
- In case the language code is not correct, the characters of

the text file may be displayed broken or may not be 
displayed.

View the previous or next text file
1 Press or button to go to the previous or next page.

- The text file moves to the first page when pressing 
button in the last page.

- The text file moves to the last page when pressing 
button in the first page.

2 Press and hold or button for two seconds. 
Then, the previous/next document will be opened.

- The player supports maximum 99999 pages.
- If you selects the automatic page moving at the EZ menu,

the page will be automatically moved at every interval
defined.

View Text
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EZ menu
You can set the desired function or switch to the other mode
using EZ menu.

1 Press ez button to display EZ menu screen while viewing
text file.

2 Press or button to move to the desired item.

3 Press or SELECT button to move to the submenu.

4 Press or SELECT button after changing the setting

by pressing or button.

- Press button to exit without change.

5 Press ez button to exit the EZ menu.

Bookmark Set/Move/Cancel
You can move to the point you set while playing the text.

1 ez button > [Bookmark] > [Set]/[Move]/[Cancel]

- If the bookmark is not set, [Move]/[Cancel] is not set.

2 The bookmark is changed to [Set1] when you press 
or SELECT button on the [Set] mode.

- Press or SELECT button to save the setting.

- Press button to exit without change.

- You can set the bookmark up to 10.

- When the list is updated, the bookmark will be automatically
disabled.

- The bookmark is changed to [Move1]/[Cancel1] when you

press or SELECT button on the [Move]/[Cancel] mode.

3 Select bookmark number to move or cancel and then the
bookmark is moved or canceled.

View Text
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Media selection
You can listen to music or radio while viewing the text file.
(FM radio reception is optional.)

1 ez button > [Media] > [Music]/[Radio]

- If the [Media] is set to the [Music]/[Radio], the [Media] will
be automatically changed  to [Music]/[Radio].

2 ez button > [Music]/[Radio] > [Back]/[Cancel]/[Next]/
[Previous]

- [Back]: You can go to the [Music]/[Radio].
- [Cancel]: The [Music]/[Radio] mode will be turned off, the 

mode will be changed to [Media].
- [Next]/[Previous]: Plays the previous or next music in case 

of [Music] mode.
Plays the previous or next channel if there
are stored channels in case of [Radio] 
mode.
Displays the [Cancel] or [Back] the if there
are no stored channels in case of [Radio] 
mode.

Auto Page

1 ez button > [Auto Page] > [Off]/[1sec] - [10sec]

- The page will be automatically moved according to the 
setting.

Page Find

1 ez button > [Page Find]

2 Press or button to move the page. Then input the

page count by pressing , .

3 Press or button to select Ok. Then press SELECT
button.
- Moves to the corresponding page.

Brightness
You can adjust the brightness level from 1 to 4.

1 ez button > [Brightness] > [1 - 4]
- The default brightness is 3.

Information
Displays the information of the text file.

1 ez button > [Information] > [View]
- You can check the information of file name, file size,

page and volume.

View Text
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Voice recording
1 Move to the Home menu, and press or button to

select [Record] mode.

2 Press or SELECT button to open the recording 
standby screen.

3 Press REC button to start recording.

4 To pause recording, press button.

5 Press or button to select “End”, and press or
SELECT button.
- Select “Continue” to resume recording.
- The recorded files will be stored under Record folder

named V060925_0001 (Year Month Date_Order)

6 To stop recording, press REC button.
- Files less than one second long will not be stored.

7 Refer to “Recorded file” on page 32 to play prerecorded
files.
- Files less than one second long will not be stored.

Recording
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FM broadcasting reception screen
* Optional according to model. (See on page 13)

To listen to the FM radio
1 Move to the Home menu, and press or button to

select [Radio] menu.

2 Press or SELECT button to open the reception
screen.

FM radio reception (Optional)
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To search the FM radio stations
Manual Search

1 In Non Preset Mode: Press or button to gradually
increase/decrease the frequency.

Automatic search

1 In Non Preset Mode: Press and hold or button for
two seconds to automatically search the stations.
- Press any button to stop automatic search.

2 When the frequency is searched, the channel will be fixed
and the corresponding frequency will be automatically
received.
- Reception may be weak in some areas.
- As earphones function as antennas, only LG Electronics'

earphones guarantees the reception quality.

To set FM radio channel
Manual channel setting

1 Press ez button while listening to the radio and then EZ
menu screen displays.

2 Press or button to move to [Channel Setting] and

then press or SELECT button.

3 Press or button to select to [Manual] and then press

or SELECT button.

4 Press or button to control the frequency.

5 Press or button to select “Save”. Then press
SELECT button to save the channel.

- By pressing or button up and down, you can change
the frequency and save maximum 20 channels.

- You can delete the channel using EZ menu.
6 Select “End” to end manual channel setup.

Automatic Channel Setting
1 Press or button to move to [Channel Setting] and

then press or SELECT button.

2 Press or button to select to [Auto] and then press

or SELECT button.
- You can save maximum 20 channels and existing

channels will be deleted.
- In an area with weak reception, the detected channels may

be less than 20.

FM radio reception (Optional)
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To search Channel (Preset Mode)
1 Press MENU button while listening to the radio.

- The list of saved channels will appear.

2 Press or button to select channel.

3 Press or SELECT button.
- Radio reception screen displays.

EZ menu
1 Press ez button to display EZ menu screen in the list of

saved channels.

- Channel : Deletes the selected channel.
- Information : Displays information of the selected channel.

To toggle of channel/frequency
mode
1 Press ez button while listening to the radio and then EZ

menu screen displays.

2 Press or button to move to [Radio Mode] and then

press or SELECT button.

3 Press or button to select to [Preset Mode] or [Non

Preset Mode] and then press or SELECT button.

Set/Cancel Mute
1 Press button while listening to the radio. Then, the

sound will become mute.
- icon will appear and the sound will become mute.

2 Press button to return to the normal.
- icon will disappear.

FM radio reception (Optional)
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To record FM radio broadcasting
1 To record while listening to the radio, press REC button.

- The recording time will be displayed and the recording will
start.

2 Press button to pause.

3 Press or button to select Continue or End. Then,

press or SELECT button.
- If you select Continue, recording will be resumed.
- The recorded files will be saved under Record folder named

F060925_0004.MP3 (Year Month Date_Order)

4 To stop recording, press REC button.
- Files less than one second long will not be saved.

5 Move to “Recorded file” menu to play.
- Home menu > [Music] > [Recorded file]

(Refer to page 32.)

EZ menu
You can set the desired function or switch to the other mode
using EZ menu.

1 Press ez button to display EZ menu screen while listening
to the radio.

2 Press or button to move to the desired item.

3 Press or SELECT button to move to the submenu.

4 Press or SELECT button after changing the setting

by pressing , button.

- Press button to exit without change.

5 Press ez button to exit the EZ menu.

FM radio reception (Optional)
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Media selection
You can view to photo or text while listening to the radio.

1 ez button > [Media] > [Photo]/[Text]

- If the [Media] is set to the [Photo]/[Text], the [Media] will be
automatically changed to [Photo]/[Text].

2 ez button > [Photo]/[Text] > [Back]/[Cancel]/[Next]/
[Previous]

- [Back]: You can go to the [Radio].
- [Cancel]: The [Radio] mode will be turned off, the mode will

be changed to [Photo]/[Text].
- [Next]: You can listen to the next channel. 
- [Previous]: You can listen to the previous channel. 

Channel
You can save or delete the channel.

1 ez button > [Channel] > [Delete]/[Save]
- You can only delete the channel on the [Preset Mode].
- You can only save the channel on the [Non Preset Mode].

Channel Setting
You can automatically/manually save channel.

1 ez button > [Channel Setting] > [Auto]/[Manual]

Radio Mode
You can select the channel mode or frequency mode.

1 ez button > [Radio Mode] > [Preset Mode]/[Non Preset
Mode]

Brightness
You can adjust the brightness level from 1 to 4.

1 ez button > [Brightness] > [1 - 4]
- The default brightness is 3.

Information
Displays the information of the radio frequency.

1 ez button > [Information] > [View]

FM radio reception (Optional)
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Setup menu structure
* Menu tree structure varies according to product models

(See on page 13)

Music
• Play Mode

- [Repeat One]: Plays the current file repeatedly.
- [Play All]: Plays the music in order within the selected folder.
- [Repeat All]: Plays the music in the repeatedly within the 

selected folder.
- [Random Play]: Plays the music randoml within the selected

folder.
- [Random Repeat]: Repeats the music randomly within the 

selected folder.
• Play Speed: You can set the playing speed of

MP3 files.
- You can select [0.3 Times], [0.5 Times], [1 Time], [1.5

Times], and [2 Times].
- The default value is X1.
- MP3 files sampled less than 32KHz can support only X1.

• Sound Effect
- EQ: You can set the sound effect.

(AUTO EQ, NORMAL, POP, ROCK, R&B/SOUL,
HIPHOP/RAP, JAZZ, CLASSICAL, DANCE, LIVE, USER
EQ)

- 3D Sound: You can experience 3D sound effects.
(Off, 3D Expander, Stadium, Concert Hall, Club, Room,
Bass Boost, X-live)

• Fade In: You can gradually increase the volume 
to protect ears.
- You can select [On] or [Off].

• ID3 tag: Displays information of the music file.
- You can select [On] or [Off].
- In case you selects [On], the title and the artist will be

displayed.
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• Scroll speed: Sets the speed of the file name and ID3 
tag information in the music playing 
mode.

- You can select [Off], [X0.5], [X1], [X2], and [X3].
• Background Setting:You can select photo file for

music background on the photo mode. 
[Default Image] - Factory default Image will be displayed.
[Album Art] - Display Album Art.
[User Image] - You can select photo file for music 

background on the photo mode.
- First, select the [Photo] in main menu.
- Select the photo file for music background.

(ez button > [Background] > [Music Background])
- Second, select the [Setup] > [Music] > [Background

Setting] > [User image] 

Photo
• Slide Show: You can select the slide show.

- You can select [On] or [Off].
• Slide interval: You can select the slide show 

interval.
- You can select [2 sec], [3 sec], [4 sec], or [5 sec].

Radio (Optional)
• Mode: You can set the reception mode.

- You can select [Stereo], [Mono] or [Auto].
• Level: The lower, the more frequency channels.

- You can select [High], [Standard], or [Low].
• Country: You can set the reception area.

- You can select [Korea], [Japan] or [Others].

• Reserved recording: You can reserve the FM radio 
recording.
- You can set the frequency for reserved recording.
- Reserved recording feature is activated only when the

player is turned off.
- You can set only one reserved recording.
- Recording can be made for maximum 23 hours and 59

minutes.

Record
• Recording quality: You can set the quality of the

recorded file.
- You can set [96Kbps], [128Kbps], or [192Kbps].

• VAD: In case of voice recording, recording will 
automatically stop upon mute sound and will 
resume upon reception of the voice signal.

- You can select [On] or [Off].
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Text
• Text Color: You can set the character color in

the text mode.
- You can select [White], [Gray], [Yellow], [Blue], or [Pink].

• Auto Page: After the certain time passes, the player
will automatically open the next page.

- You can select [Off], [1 sec], [3 sec], [5 sec], or [10 sec].

Battery Save
• Auto Display off: If no button is inputted during the

given time, the LCD will be 
automatically turned off.

- You can select [Always On], [5 sec], [10 sec], [30 sec], or
[60 sec].

• Auto Power off: If no button in selected in the standby 
mode for playing, the screen will be 
automatically turned off.

- You can select [Off], [30 sec], [1 min], [5 min], or [10
min].

Time
• Sleep Reservation: When the defined time passes, the 

player will be automatically turned 
off.

- You can select [Off], [10 min], [30 min], [1 hour], 
or [2 hours].

- If you sets the turning-off reservation, the player
will automatically store files and turn off at the reserved
time.

- After the player is turned off at the reserved time, the
turning-off reservation will be automatically cancelled.

• Time Setting: Sets the current time.
- You can set years between 2001 and 2099.
- When downloading files in the MTP mode, the time

setting of the player will be synchronized with the time
setting of the PC.

• Alarm Setting: The music playing will automatically
resume at the alarm time.

- You can select [Off], [Once], or [Always].
- In other modes than the music playing mode, the player

will enter into the FM mode when the resume is can-
celled.

- Those models which do not support the radio mode
start with the home menu screen when no music file
is available.
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General setting
• Resume: This feature remembers the last playing

status (for example, the file or playing time) 
and automatically returns to the last playing 
status.

- You can select [On] or [Off].
- If you turns off the player in Recording/Setup mode not

in playing mode (for music, radio (optional), video, photo,
and text) and turns it on again, the player will enter into
Home menu.

• Rebuilding: You can search the downloaded
files and update the list.

- You can select [Yes] or [No].
- If you selects [Yes], the list will be updated. If you selects

[No], the player will return to the general setup screen.
- As updating the list may take time, check the battery

status in advance.
• Initialize Setting: You can initialize the setting of 

the player.
- You can select [Yes] or [No].
- If you selects [Yes], the player is automatically turned off

after the player is initialized.
- If you selects [No], the player moves to the previous

menu.
• System Info: You can check product information.

- The firmware version, the entire memory space, the
used memory, and the remaining memory space are
displayed.

• Language: You can select the language.
- Korean, English, Chinese (Traditional), Chinese

(Simplified), French, German, Japanese, Portugese,
Russian, Spanish, Italian

• Format: You can delete all data in the memory,
and initialize the memory.

- You can select [Yes] or [No].
- If you selects [Yes], formatting will be made. If you

selects [No], the player will return to the general setup
screen.

- Back up the data stored in the player before initializing
it.

- Deleted data cannot be recovered.
• Brightness: You can adjust the brightness level from 1

to 4.
- The default brightness is 3.

USB
• Mass Storage Class (MSC) mode

- The player will function as a general removable storage
in this mode.

• Media Transfer Protocol (MTP) mode
- The MTP applies the latest technology of Microsoft to

support the multimedia devices. It is recognized as a
mobile devices and compatible with Windows Media
Player10.
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LG Media Center
The LG Media Center program is an integrated data
management program developed for users to more
conveniently use the MP3 player.

• Features of the LG Media Center
- You can efficiently manage music, video, photo,

and text file through the Media Library rule and down-
load them to the MP3 player.

• Contents Service menu
- Music Store: Music purchase, Streaming service
- Media Cast: Music, vide, broadcasting service purchase

(Period-based service)
- For more information, see the Help menu of the program

or visit www.lge.com.

LG Media Center - Firmware
Updating
Connect the player to the PC where the LG Media
Center is installed to download a new version of
firmware.
- Functions only in the Internet-connected PC.

1 Connect one end of the USB cable to the USB port of the
PC with the LG Media Center installed and the other to
the USB port of the player.

2 The LG Media Center will compare the firmware versions
of the player and the server. If it detects a new firmware
version, it asks you whether to update the version.

3 Click on [OK] button to copy new firmware to the MP3
player.

4 Upon updating, new version firmware will be copied to the
MP3 player.

5 To safely remove the device, remove the USB cable.

6 When "Firmware upgrade?" message is displayed, click

on button.

7 The firmware updating progress bar will be displayed.
After completion, the power will be automatically turned
off.
- Wait till the power is automatically turned off.

8 Turn on the MP3 player, and check the updated version
of firmware.
- *** “General setting” on page 52 ***

View the manual
You must install the Adobe Acrobat Reader to read the man-
ual.

Installation of the Adobe Acrobat
Reader
Click on “Adobe Acrobat Reader” after inserting the opera-
tion program CD into the CD-ROM.
- You can view the owner’s manual.

Using the application program
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Q :The player will not be turned on.
A : Check whether the battery is remaining.
A : Connect the AC adapter and charge the battery.

Q : The screen is blur.
A : Avoid direct sun rays and adjust the brightness.
A : Check the LCD brightness.

Q : The button does not function.
A : Check whether the Hold feature is active.

Q : The characters on the display look broken.
A : Download the font file from the website, and copy it 

to Config folder.
A : The Config folder is displayed only in the MSC mode.

Change to the MSC mode (In case of the MTP mode,
copy the font file to the data folder)

Q : The noise is severe during listening to the radio,
and the reception is poor. (Optional)
A : The earphone functions as an antenna. Be sure to

handle carefully.
A : Slightly change the directions of the player and the

earphones.
Q : After the files are downloaded, the play list will not

show the newly added files.
A : Update the list in the Setup menu.
A : Format the product, and download the file.

Q : After the firmware is updated, the player is not nor-
mally functioning.
A : Reset the product (See page 28)
A : Back up the data, and format the player.

Q : Sometimes, files are not downloaded.
A : Check the USB mode of the player (See page 19 -

page 23)
Q : Files can not downloaded.

A : Check the USB mode. Some files can be down 
loaded depending on the USB mode. All files can be 
downloaded in the MSC mode.

Q : My PC can not detect an MP3 Player.
A : Check the USB Mode. In the case of Windows 98 

SE/ME, USB Mode should be set to MSC in Setup 
Menu.

A : Check if the USB driver on the provided CD is 
installed.

Q : AVI file will not play.
A : Only video files transcoded by LG Media Center can

be played. Make sure the files to be played are 
converted by LG Media Center. Refer to the LG 
Media Center [Help] how to transcode your files.

Q :Characters are not shown properly in text files.
A : If the text file is encoded in a format that your text file

viewer doesn't understand, text data seem to be 
garbaged or corrupted.

A : You should convert the text file into Unicode on a PC
which supports your language of choice and 
download it.

Troubleshooting
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Capacity 1GB/2GB/4GB

File system FAT32

OS for MP3 Player Device Win98SE/ME/2000/XP

OS for LG Media Center Win2000 / XP

Interface USB 2.0

Dimensions 42 (W) X 70.5 (H) X 12.5 (D)

Weight 42g (1.48oz) (with battery) / Depends on the product model.

Operating temperature 0°C + 40°C

Frequency range 20Hz ~ 20kHz

Signal-to-noise ratio 85dB

Channel response 35dB (1kHz)

Maximum output 18mW+18mW

Frequency range 87.5~108MHz

Signal-to-noise ratio 50dB

Channel response 25dB(1kHz)

Antenna Earphones antenna

Video About 8 hours

Viewing Photos while playing music About 8 hours

Audio About 35 hours (for 128Kbps/44.1KHz EQ normal)

AC adapter DC5V, 1A

Battery (Built-in) Lithium Ion DC 3.7V 600 mAh Rechargeable Battery

Memory

PC

General specifications

Audio

FM radio
(Optional according
to model)

Playback time

Power supply

Type Item Specifications
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http://www.lge.com
Information related to the product is available at this site.
- By updating the firmware, you can improve the 1performance of the product.

Audio MP3, OGG, WMA, WAV (ADPCM), ASF

video LG AVI

Image viewer JPG/BMP

Text viewer TXT

Display 1.77" (TFT LCD) / 260,000 colors/ 15 frames

Files

Display

Type Item Specifications

Note:
Some parts of the storage space of the MP3 player are usually used for storing the information that is internally treated.
Therefore, the storage capacity that can be actually used may be somewhat smaller than specified in the manual. 
(The size of the storage space for the internally treated information can be changed for product upgrade without any notice
to the end users.)



Supported file specification
MP3 Decoder
- MP3 decoding support specification including variable bit

rate (VBR)
MP3 Encoder
- 44.1KHz, (96Kbps, 128Kbps, 192Kbps) Spec
WMA Decoder
- WMA (ASF-audio only) Decode Support

- (S): Stereo,  (M): Mono

OGG Decoder
- Q(-1) ~ Q(10) Support
ADPCM Decoder
- WAV File Format (MS-ADPCM) Decode

Specifications
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32 OK OK OK

40 OK OK OK

48 OK OK OK

56 OK OK OK

64 OK OK OK

80 OK OK OK

96 OK OK OK

112 OK OK OK

128 OK OK OK

144 OK OK OK

160 OK OK OK

192 OK OK OK

224 OK OK OK

256 OK OK OK

320 OK OK OK

Bitrate 32KHz 44.1KHz 48KHz
Mpeg1
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